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- 2|)7MY =, 7| ZHHOA "Download Center Intel®' & T=ACHE EH,
Additional Software A~
(LE T Intel® FPGA SDK for OpenCL™ Pro Edition Software Version 21.4 706030 12/15/21 214

Intel® FPGA SDK for OpenCL™ (73)
Intel® FPGA Simulation Tools (72)

Intel® FPGA Programming Software B Intel® Quartus® Prime Pro Edition Design Software Version 21.4 for Linux 706104 12/14/21 214
(66)

Intel® SoC FPGA Embedded
Development Suite (SoC EDS) (52)

T Intel® Quartus® Prime Pro Edition Design Software Version 21.4 for Windows 706105 1214/21 214
DSP Builder for Intel® FPGAs (50)
Intel® FPGA Protocol Tools (49)
Intel® High Level Synthesis Compiler
(30) B Intel® Advanced Link Analyzer Pro Edition Software Version 21.4 for Windows 706039  12/14/21 214
Intel® FPGA Power Thermal
Calculator (20)
eveiopmentS Mol el 3 Intel® Quartus® Prime Lite Edition Design Software Version 21.1 for Linux 684215 11/03/21 211
SoC FPGA (6)
Intel® FPGA Device Family A

T3 Intel® Quartus® Prime Lite Edition Design Software Version 21.1 for Windows 684216 11/03/21 211
CLEAR
Intel® Arria® (74)
Intel® Cyclone® (74)

B Intel® Advanced Link Analyzer Standard Edition Software Version 21.1 for Windows 684357 11/03/21 21

Intel® Stratix® (52)

Intel® MAXE (40)

- "Intel® Quartus® Prime Lite Edition Design Software Version 21.1 for

Windows"E 1EH

Downloads

Multiple Download Individual Files Additional Software Copyleft Licensed Source

Multiple Download

Intel® Quartus® Prime Lite Edition Software (Device support included)

Download Size: 5.6 GB )

Quartus-lite-21.1.0.842-windows.tar SHA1: 8c33755ee8eac049392d506014c3c96ba3be37e7

What's Included?
** Nios® Il EDS on Windows requires Ubuntu 18.04 LTS on Windows Subsystem for Linux (W5SL), which requires a manual installation.
** Nios® Il EDS requires you to install an Eclipse IDE manually.

- 'Download"E Z&
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Ok Installing Quartus Brime

Lite Edition (Free) 21.1.0.842

Setup - Quartus Prime Lite Edition {Free) 21.1.0,842

The Quartus Prime software requires that your system have
Recormmendations” section in the "Quartus Prime Software a

docurnentation/lit-rn, htrl) for detailed mermaory requiremnents

www/Us,//en/products/programmable, html,

Welcome to the Cluartus Prime Lite Edition (Free) 21,1,0,842 Setup Wizard,

compile designs targeting specific devices, ¥ou can check the "Memory

Release Motes” (hitps:/ e, intel, com/content/www/us /en/programmable/

For rore information about Intel FRGA software, go to hitps:/Awwew, intel, com/contenty/

sufficient physical Rak to
nd Device Support

for a particular device,

< Back

Mext > Cancel
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(b Installing Quartus Prime Lite Edition (Free) 21.1.0.842

Select Components

Select the components you want to install

2- Quartus Prime Lite Edition (Free)

Quartus Prime (includes Nios || EDS) (9235MB)
Quartus Prime Help (507.9MB)

=] Devices

Arria Il (536.5MB)

Cyclone IV (516.3MB)

Cyclone 10 LP (293.5MB)

Cyclone W (1430.9MB)

MAX 1A (13.1MB)

MAX 10 FPGA (355.1MB)

- [v] Questa - Intel FPGA Starter Edition (A zero cost license req...
-] Questa - Intel FPGA Edition (3202 4ME)

You can add additional device support to an
existing Quartus Prime software installation
without having to reinstall the entire software
package, Use the Install Devices command on
the Tools menu in the Quartus Prime software to
get started,

Select a component for more infarmation

Whlware InstallBuilder

< Back MNext > Cancel
A A = I
- MK} RS K S2foy MAIS AISHE.
[ Installing Quartus Prime Lite Editicn (Free) 21.1.0.842 — X
Quartus Prime Lite Edition (Free) 21,1,0,842 Installation Complete
Setup has finished installing Quartus Prime Lite Edition (Free) 21,1,0,842,
Launch USE Blaster Il driver installation
Create shortcuts on Desktop
Launch Quartus Prime Lite Edition
[ Pravide vour feedback
< Back Finish Cancel
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- o »
Elle Edit View Project Assignments Processing Tocks window belp L]
r - . LR -
Praject Navigatar <% Hierarchy » GEEE W sme X W Catalog LI
Compilation Hierarchy Dwice Family | Cyclana iV
L ®| =
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* Project Directory
= Libwary
b Basic Functions
v s
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- New Project ORAOY| Cigh Zrefol A7H7F Li2CE M ZE2HES AH
MABR{R [Next) BHIES ST
Ok Mew Project Wizard *
Introduction
The New Project Wizard helps you create a new project and preliminary project settings, including the following
* Project name and directory
* Name of the top-level design entity
+ Project files and libraries
+ Target device family and device
* EDA tool settings
You can change the settings for an existing project and specify additional project-wide settings with the Settings command (Assignments
menu). You can use the various pages of the Settings dialog box to add functionality to the project
Don't show me this introduction again
Help Back Next > Finish Cancel
- ZRMEQ| XY EMQ ZZME 0|2 Project Name S Y 2stct. O|f
T = 7] it = O I — it
e B0 0127 ZEME 0% XA TaL QXD ZeME
O|E1 top-level design entry name 2 BHEA| LX|A|Z{0F SICtH UHZ
OFX|® [Next] HES SESCL
X

Q% New Project Wizard

Directory, Name, Top-Level Entity

What is the working directory for this project?
F:/trmp/Project1
What is the name of this project?

Projectl

What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity name in the

design file.

Projectl

Use Existing Project Settings...

Help

< Back Next > Einish Cancel

18
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T2

TZ2ME |-O| i =2 |I—|"‘ |- -IQ |II-"'|.i I
Z=ME EIY Project Type = X[E2HCh X2 Al&S=E ==
! iect 2 MEHS} HES Zalsic}
Empty project S MEASI [Next] HHES 2250}
Gk New Project Wizard be
Project Type
Select the type of project to create.
@) Empty project
Create new project by specifying project files and libraries, target device family and device, and EDA tool settings.
Project template
Create a project from an existing design template. ¥ou can choose from design templates installed with the Quartus Prime software, or
download design templates from the Design Store.
Help < Back Mext > Finish Cancel
pSIi= | iz sh |5’| | |.O _I.OIQ MEHS I. Qld} o O -I
EHEN =AIZ C|XpQl mbYE MEisic) gut¥o=z X
xS M= mShA|ZD CIXFQI melo] gloo HES
(o] 5 | |-O _I-OI | ol Hi H—lEQ = -I INPS! _I.OIQ MEHS
oF CAtQl mUol /A M= HES = AY oS MEish
ES Zzls} |.
—= = 1= .
Q% New Project Wizard X
Add Files
Select the design files you want to include in the project. Click Add All to add all design files in the project directory to the project.
Note: you can always add design files to the project later
Eile name; Ad
o A Add All
File Name Type Library Design Entry/Synthesis Tool HDL Version [
Y
Properties
Specify the path names of any non-default libraries. | User Libraries..
Help < Back Next = Finish Cancel
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EHMEOAM ALY C|HO|AE MEHBICE Family = 'Cyclone IV E'E
b1, AL 7ts%h CiHO|A 228 27| ot RHULZE, Package &

A, Pin count £ 256, Core Speed grade & ‘8’2 MEiBIC} SITHO]
MM 7hs%h ClHIO|A FE 5 'EPACE6F17C8'S MEHSELD [Next]

x
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)

T 30
rm rir
mjo
mju

I}

ot
|

Gh New Project Wizard

X

Family, Device & Board Settings

Device Board

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.
Device family Show in ‘Available devices' list

Eamily: | Cyclone IV E

Package: FEGA hd
Device (21 Pin count: 256 bt
Target device Core speed grade: | 8 -
Auto device selected by the Fitter Mame filter.
8. Specific device selected in ‘Available devices' list V| show advanced devices
Other. nfa
Available devices:
Name Core Voltage LEs Total 1f0s GPI10s Memory Bits Embedded multiplier 9-bit elements
EpsceeFT7Co 275400
EP4CET10F17CE 1.2V 10320 180 180 423936 46 -
1 b
Help < Back ‘ Mext > | Finish Cancel

TZHMEOM AI2E EDA Tool 2 MHSICH A2 0|ME
S

fISiM “Tool
Name”2 "QuestaSim”, “Format(s)’< “Verilog HDL'2 41 EHBHC},

Q% New Project Wizard X
EDA Tool Settings
Specify the other EDA tools used with the Quartus Prime software to develop your project.
EDA tools:
Tool Type Tool Name Format(s) Run Tool Automatically
Design Entry/Synth... | <None> ¥ | <None> Run this tool automat ynthesize the current design
simulation Questasim * | verilog HDL - Run gate-level simulation automnatically after compilation
Board-Level Timing <None> =
Symbol <MNone> >
Signal Integrity <Mone> b
Boundary Scan <Mone> v
Help < Back Next = Einish Cancel
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= |- | MEHS mE2dE MY "'o-'-|.—| [ ] H.lEQ =ik |-
leﬁx |_-|—||_I-_§_|_ =20= %.l'|_|o_l_ Finish —= E—Il_H:
Q¥ New Project Wizard X
Summary
‘When you click Finish, the project will be created with the following settings:
Project directory: F:/tmp/Project1
Project name: Projectl
Top-level design entity: Project1
Nurmnber of files added: 1]
Nurnber of user libraries added: 1]
Device assignments:
Design template: nfa
Family name: Cyclone IV E
Device: EPACEGF17C8
Board: nfa
EDA tools:

Design entry/synthesis:
Simulation:
Timing analysis

Operating conditions:

<Mone> [<Mone>)
QuestasSim (Verilog HOL)
0

VCCINT voltage: 1.2v
Junction temperature range: 0-85 §C
Help | < Back Next > Einish | Cancel
— — = —
ZEME MH0| UREHN HE EAS0 Z2HE

LHEFEHCE

Bz 0]F0|

O Cuartus Frima Lite Tdiien - F/tmayProjeet ] Freject] - Projact!

><

Dle Edt Miew Project Aisignmests Pocessing Jook Window Hep ritel B L]
OFH <50 9 [poen S EES D Ee DA R @
Froject Navgater, &y toerechy = QW@ @ 0 Catag BE|
== - x =
i Eyclane I E: ERACEEE17ER vk mstaled 1P
s = Progea Directory
. S
Quartus Prime Pluguniinsnt
Tasks ‘Compiation =@®m .
- » l:omnﬁeDHlRl!T”k

R

Ly e

b PR Medli Wi + add
g o | |0 A (& (A [T srime $pea. | Mrindnen
:1’“1: ID Message
§.
§|wsw-. Processing

o DO-O0r00
Verilog == VHDL 2 AA¢t2H FE Ot MAM8|0F SOk [File]-[New]
HFE ZEStHLE [New] OIO|Z22 S&IoiC}t O2{H ZZHMEOA AtET
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AA mo| FFE MEG £
MASIEZ 'Verilog HDL File'S MEHSI [OK] H
AAE = 'VHDL File's MEHSID [OK] HES

% New

Mew Quartus Prime Project

~ Design Files
AHDL File
Block Diagram/Schematic File
EDIF File
Qsys System File
State Machine File
SystemVerilog HDL File
Tcl Script File
VHDL File

¥ Memory Files
Hexadecimal (Intel-Format) File
Memory Initialization File

* Werification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
Signal Tap Logic Analyzer File

University Program VWF
* M#hearCilas

L]

EoS =gl &
£E2 28 o
=als

= 2| otCt,

| OK | Cancel Help
B~ — B~ —
. ACE EASE S MHASICE 0| I AEQ| 0|22 HICA| ZE2XME 0|2
— = -1 O - T O - . _— a — - _— 11— a
= oIt A (Proiect1) & AHsHOE Bt
S &2 orHl(Project1) M&SOF St}
Sk Quartus Prime Lite Edition - F-tmp/Project1/Project1 - Project - m] X
File Edit View Project Assignments Processing Tools Window Help search Intel FPGA
0 | alio] Project1 MR XX P EFES Sa20E 9
Project Navigator| 4% Hierarchy - QB@® | U projectiv X 1P Catalog le®
EntityInstance BE o687 U I S SR A * X =
4% Cyclone IV E: EPACEGF17C8 1 module projecti(a, b, and_out, or_out, not_out); ~ i Installed IP
iy = 2 input a, b
Project] 3 output and_out, or_out, not_out; ~ Project Directory
4 assign and_out = a&b;
5 assign or_out = alb; No
6 assign not_out= ~a; - L
7 endnodule Librery
» Basic Functions
» DSP
* Interface Protocols
¥ Memory Interfaces and Controllers
» Processors and Peripherals
» University Program
Search for Partner IP
Tasks Compilation ~ =lE® ®
Task =
= P Compile Design
b P Analysis & Synthesis
* P Fitter (Place & Route)
» P Assembler (Generate programm
b P> Timing Analysis
> st Wiriter - .
. » ENA Netlist Wit i) |+ ada.
®
Al (@ A4 Y <<Filters> $cind S8 Find Next
i
= |Type 1D message
HIE »
8| system | Processing
0%  00:00:00
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MY

ddstn M ot 20 Z=2HEZ O|0{M ZADBHALL

of ZEZMEE ZO{OF BHCL Quartus Prime Design
7| 2tHOA [File]-[Open Project] M’ & MEHSIT, QESIHE
Z2HE It (Projectl.qpf)S MEHSH 7|E ZEMEZ QQENAM 7|EL

ZZHMEZS O|0{A EA L},

b. ZE(Verilog, VHDL) It (Compile)

- ZE Hd2 OIXH ZoYst = gl Synthesis SHOF $tCt o O|EH
&%} Behavior 22 HAEJAHLE X[AH ™S EHA RTL: Register Transfer

Level 2 EHEl 3|29 T3t YEY Abstract Form & +=2| A O|E Logic

Gate £ oidt= 1PIO|CH ZHIpYStEH [Processing]-[Start Compilation]

M+ =SE5tAHLE [Start Compilation] EF= OFO|Z2E &5t HF

ZAntsict
Ok Quartus Prime Lite Edition - F-/tmp/Project1/Project] - Project - [m] X
File Edit View Project Assignments FProcessing Tools Window Help [ — ®
(s roecn Jrssr e oaom o
Project Navigator] 4% Hierarchy ~QEE® | € rrojectiv X IP Catalog Ie@®
EntityInstance MT EEafN 0w P2 o X =

4% Cyclone IV E: EPACEEF17CE

module Projectl(a, b, and_out, or_out, not_out); - & nstalled IP
input a, b;
* project TB ~ Proiect Dit

1

2

3 OUTpUT and_out, or_out, not_out;
4 assign and_out = a&b;
5
6
7

assign or_out = alb;
assign not_out= ~a;

endmoduTe 7 Library

b Basic Functions

b DsSP

¥ Interface Protocols

@ search for Partner P
Tasks Compilation v =@ 0mE

Task
~ P Ccompile Design

b P Analysis & Synthesis

Al QA4 ~N <<Filters> 88 £ind 88 Find Next

nE@e| "

Type ID Message

System | Processing

0%  00:00:00
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(G Quartus Prime Lite Edition - F/tmp/Project/Project? - Projectl - [m) X
File Edit View Project Assignments Processing Tools Window Help )
0= r Project | S & P ES SALDE @
Project Navigatar| 4 Hierarchy v QM@ 8@ | projectiv X | Compilation Report - Project1 X IP Catalog He®
e vt s o) T X =
A% Cyclone IV E: EPACEBF17C8 BB Flow Summary @, <<Filter>> ~ b Installed 1P
E® project1 EE Flow settings Flow Status Successful - Wed Mar 23 10:03:23 2¢ ~ Project Directory
ES Flow Non-Default Global Settings Quartus Prime Version 21.1.0 Build 842 10/21/2021 5 Lite
E= Flow Elapsed Time Revision Name Projectl - Library
EE Flow 05 summary Top-level Entity Name Project1 + Baeic Functions
Family Cyclone IV E
El FlowLog ) psp
) . . Device EP4CE6F17C8
Analysis & Synthesis
ly i Timing Models E— b Interface Protocols
»
Fitter T (e Cemmie 276272 (<1%) * Memory Interfaces and Controllers
4 Assembler Total registers o } Processors and Peripherals
i 1| M Timing Analyzer Total pins 5/180(3%) * University Program
r EDA Netlist Writer Total virtual pins o
= Search for Partner IP
= Cogokaicn T ERe® © Flow Messages Total memory bits 0/276,480(0%)
Task = © Flow Suppressed Messages Embedded Multiplier 9-bit lements 0/ 30(0 %)
* P compileDesign TS Tz
b P Analysis & Synthesis
» P Fitter (Place & Routs)
b P Assembler (Generate programm
» P> Timing Analysis
» b A
] ) L2RK] » +
® o _o
ALl (DA A (A <<Filter>> 88Eind $8Find Next
T
= | Type ID Message E
I ) RUNNTNg Quartus Prime EDA NetlisT writer
[ ] command: quartus_eda --read_settings_files=off --write_settings_files=off Projectl -c Projectl
j, 18236 Number of processors has not been specified which may cause overloading on shared machines. Set the global assignment NUM_PARALLEL_PROCESSOI
1 P P Y 9 9 g
@ 204019 Generated file Projectl.vo in folder "F:/tmp/Projectl/simulation/modelsim/" for EDA simulation tool
] qQuartus Prime EDA Netlist writer was successful. 0 errors, 1 warning
293000 Quartus Prime Full Compilation was successful. 0 errors, 14 warnings
o P g
i -
g System | Processing (122)
100%  00:00:23

4.2 Al=go]H

Al =2|0| MSimulation2 Verilog =& VHDLE HASH 2|28 C|HZAT
M Z2 LROICE A[ZYO[MHSHX| @ FPGAO| CH2=ESHY A
UKL Moz 2K g2 Me CHZo| X feoz 2
ADECH M2t AlZZo|HeRE HAE HASBT = FPGAOIAM A=
1% =gt "ERO|ICE  Intel-AlteraOfl M=  VWF(Vector Waveform  For
ArESte AlEE0| EFE N3ISt Uen, Z=EHXS0| ARESH|Of
HEo|ch Al=golde 8 oS XEstn Al oldE Tt =

— T
ot BAof B

rir

e g

0 oot
my e 3 >§ N 30

2 H

|_

0
rot o

0
r
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Mdo| Y mds A Fst7| fI8 [File]-[New] HwS
E o
]

. Y3 o F ‘University Program VWF'E MEistD [OK] H
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O New *

State Machine File
SystemVerilog HOL File
Tel Seript File
Verilog HOL File
WVHDL File

* Memory Files
Hexadecimal (Intel-Format) File
Mermory Initialization File

T Verification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
Signal Tap Logic Analyzer File
University Program VWF

* OtherFiles
AHDL Include File
Block Symbol File
Chain Description File
Synopsys Design Constraints File
TextFile

OK | Cancel Help

b, A& ZE F7}

- Simulation Waveform Editor &0| L{EfLIH, AH Oisd=2 K-S 2{sH
VWF Lt2o|l &H Mz E UG OF oLt WX UYEH ZEE R
M= =tHO| 2AF ZE/LE FE0| LIEIL HOA OR2A EZFE

=2

— 1
[Insert Node or Bus..] H'mE MEHSI™H [Insert Node or

Ok Simulation Waveform Editor - F:/tmp/Project1/Praject1 - Project! - [Waveform1.vwi] - O hS

Eile Edit View Simulation Help Search Intel FPGA e
R KO A ZEEREE TR A [
Master Time Bar: 0 ps 1 } | Pointer |677.16ns Interval: |677.16 ns Start: End:

Valueat  (2ps 80.0ns 160,0ns 2400ns 320,0ns 4000ns 480,0ns 560,0 ns 6400 ns 7200ns 8000 ns 8800 ns 960,0ns

Name :
0ps Jps

0% 00:00:00
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(oW Insert Node or Bus x
Name: Use Node Finder to insert . OK
Type: INPUT v Cancel
Value type: | 9-Level hd
Node Finder...
Radix: Binary =
Bus width: |1
Start index: |0
Display gray code count as binary count
Insert Node or Bus &0|A| [Node Finder.] HES 22/5l™ Node Finder
&0| LIEHACE Filter:Ol A Pins: all2 MEiSt = [List] HES Z25IH
Verilog EE= VHDL EA0M AtEE= =3 EHX} 0|50 LtEELCH
Nodes Found:0iA 2= =EZ MESt = ">>" HES 285 Selected
Nodes:2 O|SA|Z|1 [OK] HEZ ZE=SICt Insert Node or Bus HO|AME
[OK] HEE 2E5tY ’8% =L
Ok Node Finder X
Named: |* Filter: | Pins: all oK
Look in: |* List Cancel
Nodes Found Selected Nodes:
Mame Type Mame 7 Type
B a Input B a3 Input
@ and_out Cutput > | % and_out Qutput
i b Input - = b Input
% not_out Output %@ not_out Output
-Du-‘ or_out Output s % or_out Output
ERL L
LE FIPF AREH LE O[E0| EAIE Al 0] 2tFO[ LIEHHCE
ojmj AlZ2fo|Md mMYUS| O]F2 ‘Waveformvwli 2 XZEdHOF oich A
s Ags7| fisiME 05 E2fasty 28 Mz RS Agst
3 MZ P BES S YRMS g2 YL
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Gk Simulation Waveform Editer - F:/tmp/Project1/Project! - Project - [Waveform.vif]*

File Edit View Simulation

k| Q

Help

g

X
s

ZEEREE T B (E

Master Time Bar: O ps } | Pointer: |208.44 ns Interval: |208.44 ns Start: End:
value at \0ps 80.0ns 160,0 ns 240,0 ns 3200 ns 4000 ns 4300 ns 560,0 ns 640,0 ns 7200 ns 800,0 ns 880,0 ns 960,0 ns
Name = ops

» = B0

b b 8o 1 1

% andout BX o

® | notout BX 5

- orout  BX o

] QK ks
0% 00:00:00

d. AlZdo]d 4%

- AlEYHOolM HHFEEZ Y
Settings]& =2 &otH

[Functional Simulation Settings]?t [Timing S

novopt] &M= [ -voptargs="+acc" |2 & 2}

FISHAM 2O

[Simulation Options]

Gk Simulation Options

Caution: Improperly modifying these settings can cause the simulation o fail

HDL Language: ‘@ Verilog () WHDL (The language used for the testbench and netlist)

Functional Simulation Settings Timing Simulation Settings

Testbench Generation Command (Functional Simulation):

quartus_eda --gen_testbench ~-tool=modelsim_oem --format=verilog —-write_settings_files=off Project1 -c Prq
Netlist Generation Command (Functional Simulation)

quartus_eda --write_settings_files=off --simulation --functional=on --flatten_buses=off -tool=modelsim_oem
ModelSim Script (Functional Simulation}

onerror{exit -code 1}
wlibwork
vlog -work work Project] .vo
wlog -work work Waveform.vwf.vt
vsim[-optargs="racc]-c -t 1ps -L cycloneive_ver -L altera_ver -L altera_mf_ver -L 220model_ver -L sgate_ver
wed file -direction Project1.msim.ved
ved add -internal Project_ulg_vec_tst/*
wed add -intemal Project_vlg_vec_tstfi1/*
proc simTimestamp  {

echo “simulation time: $:now ps*

if { [string equal running [runStatus]] } {

after 2500 simTimestamp

1
}
after 2500 simTimestamp
run -all

quit-f

Restore Defaults Cancel

—_

2

i

tEHol =Lk o] =

Imu

AL

7FT

2f 8ot XMttt

(G Simulation Options.

Caution: Improperly modifying these settings can cause the simulation to fail

HDL Language: (@) Verilog |_) VHDL (The language used for the testbench and netlist)

Functional Simulation Settings | Timing Simulation Settings

Testbench Generation Command (Timing Simulation):

quartus_eda —gen_testbench —tool=modelsim_oem —format=verilog —-write_settings_files=off Project1 - Prq
Netlist Generation Command [Timing Simulation):

quartus_eda --write_settings_files=off —-simulation -functional=off -flatten_buses=off --timescale=1ps —-too)
MedelSim Seript (Timing Simulation};

onerror {exit -code 1}
wlib work
wlog -work work Project1.vo
wlog -work work Waveform wwf.yvt
vsim[yoptEEs=racc] ¢ -t 1ps -L cycloneive_ver -L altera_ver -L altera_mf_ver -L 220model_ver -L sgate_ver
ved file -direction Project1.msim.ved
ved add -internal Project_vig_vec_tst/*
ved add -intemal Project_vlg_vec tstfil/*
proc simTimestamp { {

echo *simulation time: $:now ps*

if { [string equal running [runStatus]] }{

after 2500 simTimestamp

1
1
after 2500 simTimestamp
run -all
quit -f

Restore Defaults Cancel
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e. AEE0]M

Simulation Waveform Editor2| Simulation HF0= [Run Timing
Simulation]2t  [Run  Functional  Simulation]0]  QIC}.  [Functional
Simulation]2 =2| AO|EQ| XA AlZhES 18{5tX| 2 Al 0|ME,
=2| Z07t 20 FCt BHHO|| [Timing Simulation]2 =2| AO|EQ| X|HA
AZPIER] Btgot ZutE 20 2=, 3 Ootdo| HHE o oFzte| X[ O
st = Znb gtol  LIERHCE  Simulation  Waveform  EditorOf A
[Simulation]-[Run Timing Simulation] HF& Z2I5tHLt TH= O0}0|E
HES St AlZgoldo] THZHAM I Z0o] AlZgo|M
A7t L2

Ok Simulation Waveform Editor - F:/tmp/Project/Project - Project] - [Project1_20220323115001 sim.vwf (Read-Only)] - [m] X
File Edit View Simulation Help )._._: - Intel EPG. ]
R E &R Z BRI R e A [ B
Master Time Bar. 0 ps 1 } | Pointer. [130.66 ns Interval: | 130.66 ns Start. End:
Valueat |[0Ps 800 ns 160,0 ns 240,0ns 3200ns 4000 ns 4800 ns 560,0 ns 640,0 ns 7200 ns 800,0 ns 880,0 ns 960,0 ns .
Name ops  Ops
- a BO
- b BO
9"-‘ and_out BX
- not_out  BX
- orout BX |
4 LR} »
0% 00:00:00
=00l AlZh HE
f. AlEgo]d AjZH HE

7| 2H-0l AE20|M A|ZF2 1usecO|X|2F [Edit]-[Set End Time] HHFE

SEIBIA AlZ2d|0|M AlZtE BEE + UL

(% End Time b
Set End Time
End Time: ‘10{0 us *
oK Cancel
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=
Aotgsto] AlZgoldMe O Z17F ZY&XHO0|HE DIGCOM-A1.22] FPGAO
CH22Eot £ HASHOF OHCf FPGAO| CHR2ZESHHE ClHO|Ao] FRE
= ;

DIGCOM-A1.20 M= Cyclone IV EP4CE6F17C8 LC|HIO|AE ArE3sI2Z
[Assignments] = Device] H70|A Cyclone IV EP4CE6F17C82 4 EAGICE
ClHOlA= Z2HMEE dde Of X[FE A7 W20 M2 MdEisi=X|
2015t = configuration deviceE  X|d5t7| {ISHAM [Device and Pin
Options..] HES ZEICL FPGAE TRI0| offr|H CIHREZEE = A7
O|O|X| 7t XX, Configuration device= M0 HHE A7 O|OIX|E
XESH7| f[siM AFEEICE.

Ok Device P4

Device Board

Select the family and device you want to target for compilation
You can install additional device support with the Install Devices command on the Tools menu

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage,

Device family Show in ‘Available devices® list
Eamily: | Cyclone IV € - Package: FBGA
Device: | All Pin count; 256

Target device Core speed grade: | 8
Auto device selected by the Fitter CEmailie
® Specific device selected in ‘Available devices® list ¥ Show advanced devices

Other. nfa

Ayailable devices:

Name Core Voltage LEs Total 1fOs GPI0s Memory Bits Embedded Itiplier 9-bit el

IEP4CEGF‘\7C3 1.2V 6272 180 180 276480 30 I
EP4CET10F17C8 1.2V 10320 180 180 423936 46
EP4CE15F17C8 1.2V 15408 168 166 516096 112
EparEr2e1zenll o 22320 154 154 ANRZSA 4

Migration Devices...| O migration devices selected

¥ Buy Software OK Cancel Help

Clafol~ M 2%

- Device and Pin Options &O| LIEFCE [Category]O| A ‘Configuration's
MEHBE & Configuration scheme:Ofl Al ‘Active Serial(can use Configuration
Device)= MEiSICE 'Use configuration device'’® X33t configuration

device= 'EPCS4'Z, configuration device 1/O voltage= '3.3V'E A7d3tCt,
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Gk Device and Pin Options - Project x
P )

Category:

Gencral

" . Specify the device configuration scheme and the configuration device.
Programming Files

Unused Pins

) Configuration scheme: IAEt\vE Serial (can use Configuration Device) > I
Dual-Purpose Pins

Capacitive Loading
Board Trace Model

Configuration mode: Standard

1O Timing Configuration device
Voltage
Pin Placement - — Jercss 2|
Error Detection CRC Use configuration device -
. Configuration Device Options ...
CvP Settings
Partial Recanfiguratian Configuration device I/0 voltage: |3 3v .I

Force VCCIO to be com patible with configuration I/O voltage

VID Operation mode
Configuration pin Configuration Pin Options...
V| Generate compressed bitstreams
Active serial clock source:
Enable input tri-state on active configuration pins in user mode
Description

Specifies the VCCIO voltage of the configuration pins for the current configuration scheme on the target
device

Reset

OK Cancel Help

Cyclone LC|HIO|AE 2{Hdol22 HMRUO| JHX|H GHO|EH7Zt HEEX]|
=Ct et Ho[HE XESHZ| €8 configuration C|HHO|A EPCS4E
AHESiOF L O{7|AM  configuration LC|HFO|AZH HIIUE[0] MME=
pof Programmable Object File?t X&E|= ClHOIAE ZSiCt O
ClHO|A= TR0l HWME OO|H7F X[RIX[X] ffenf, FRPU0| FHX|H

X%l HO|EE Cyclone C|HIO|AZ configuredtCt.

AH8otx| f= o 273

28 = E=Ch Ol PGAOIM AESHR| &

[
S
7

= " —
2oz, HEagle U0l FHEX O EHE= AS EX
A
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(h Device and Pin Options - Project1

Category:

General
Configuration
Programming Files
Dual-Purpose Pins
Capacitive Loading
Board Trace Model
1/0 Timing

Voltage

Pin Placement
Error Detection CRC
CvP Settings

Partial Reconfiguration

Specify device-wide options for reserving all unused pins on the device. To reserve individual dual-purpose
configuration pins, go te the Dual-Purpose Pins tab. To res individually, use the Assignment

Editor.

erve ather pins

Reserve all unused pins: IAs input tri-stated — I

Description:

Reserves all unused pins on the target device in one of 5 states: as inputs that are tri-stated, as outputs that
drive ground, as outputs that drive an unspecified signal, as input tri-stated with bus-held, or as input tri-

stated with weak pull-up.

Clafol A ¢ &

Cyclone IV C|HO|AE ClHO|AO[ oF THO| HO| H{EE[Of U=Ol, &4
Hol= ®© Rz7F ROE[0] 1 £210[A AL(X[Lt LEDRF €2 YUEH
X7 HEE0 At M2t YEY LEE C|HOo|A o ZHSHE O]
FES0| YEY XL Od?é'E._'Ef.

ClHolA  HE 257 8] Quartus Prime Lite Edition &H0f|A]

[Assignment = Pin Planner||.=& &
ofH Orgfol= Z2HE AN AFEE=

2|

L= =g

StH Pin Planner 3tHO| LIEFEICE,
OI*E:i —LEEO| Oleol

LIEHEICE EE &0 HZ2Y, 288 Xt dZE T HMsE
2ottt § Bz S gEdy e 4 L=H Ao 2T 28 BE
Haotoy,
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4% pin Planner - F/tmp/Project1/Broject! - Project! - O >
File Edit View Processing Tools Window Help Search Intel EPGA .
Report 1@ ® Pin Legend 1@ ®
Report not available Top View- Wire Bond Symbol Pin Type -
k Cyclone IV E - EPACESF17C8 S User /O
Q . User assigned If_
W . Fitter assigned |
Ii . Unbonded pad
v) = . Reserved pin
v 'fE_," Other ...
Report ) - = -
= RiEn ol = LE) DEV_OE
1@ = . i (=) DEV_CLR
Early Pin Flanning = X : {ny DIFF_n
131 W Early Pin Planning.. DIFF_p
» N -
*i [ v s} -
= .
® | Named:* v |<»|Edit] X Filter: Pins: all -
[ Mode Mame Direction Location 1/O Bank VREF Group Fitter Location IfO Standard
L] B a Input PIN_RD 4 B4_ND PIN_D5 2.5V [default)
= @ and_out Output PIN_F11 7 B7_ND PIN_B1 2.5V [default)
i Input PIN_TO 4 B4_ND PIN_D3 2.5V (default
| Bt (default
‘@ not_out Output PIN_A10 7 B7_NO PIN_A3 2.5V (default)
L% ‘@ or_out Output PN 415 7 B7_ND PIN_C2 2.5V (default)
o7 <<new node>>
-
o
T | Z2 »
0% 00:00:00
7 17}al
At
ne dghst Sofs FA| ZIUsHor siCh TSt Q0|
IS gget 20l CHA rsfop otCf. HOTESHH pof MO
A M |- _|-0|2 *'17:”5 CE 5’-I_|-O|'<'>'H2 H A A |h |-O [
S EICE pOf o2 dAE ZEE ZOogMS If d48E= CREE

El

t

. . -
ol A Xt AlSH |
2 2, configuration C|BFO|A0| MZE[D FPGAO|A 2l EICE.
| @ cousrnus prime Lte dmen gy Eragect 1 Froject] - Project] - o ®
Ble Eda Yiew Proc gssignments Pocesseg  Jooks window  belp ]
ML= r Project] S EER Ty DA R O
[Froject Navigator & Herarchy * QREE S eojectiv X | % Complation Report - Project! X o Catiog L
ntyintance TabeofContens v [ - x/=
iy Cyelene IV E: EPSCEEF1TCR BB Flow sumenaey. &, <<Filte - 3 nenabed @
BB pgyaerr T B Fiow Settings P Sucosmaful < Wed Mar 25 183751 3¢ - Profectowecory
B how eoe- ol Chskal Settings. Quartug Prima Versian 21.1,0/Dulld 142 10/21/2031 5. Lite I
BB Flow Elapsed Time Lo Loz - Libeary
= Flew 05 Summary Tap-level Entity Name Project] » Basie Function
" Family Cyzlane IV E h
= slowLog  ose
. . Crice ERSCERETTCH
Analysis & Synthesis Tining Modals Pl * Interface Protocels
v e f erfac
o Total logic slements. 262720 1%) Memary Interfaces and Ceetraliers
¢ B asseibier ot rginters ° b Brocmuens nd beepher i
¢ M Timing Analy Total pirs 5718013 %) b University Program

I EDA Methst Writer

[P
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Tatal mamnory bite

a
0] 276,480 {0% ]
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4.4 FPGAO| CI2EE

A E A2E HHAZ|7| fiMe= ZAIYE pof IYS FPGAO| CHREESHOF
SICH CHE22 pof LMYS USB Blaster2 EPCS4 configuration C|HIO| A0
CF2E2ESEA, Cyclone IV FPGA O|M AdA|Z7|= 1EZ HAYHBHCE FPGAO
CH22E517| 0| USB Blaster 702 o5& HAFHS USB ZEO| &35
otZ& 2 DIGCOM-A1.22| Y E 0| HAZsH MRS 7L

a. Programmer &%

- [Tools = Programmer] H+& Z&5tHLt [Programmer] Tth= OO|2Z
=250 Programmer £ AH@BICE Programmer HO|A  Hardware
SetupO| ‘USB-Blaster[USB-0]'2 AHEEU=X| 2Qlstd, Mode:E ‘Active
Serial Programming'@ 2 MEHSICE Z2ME mMAZ FIHSH| 25 [Add
File...] £2 28510 'Z=2HME F[{Woutput_filesWAlteraProject.pof’
ogds MEsE = [Open] == FEr0h mgol FItrH
‘Program/Configure’S M A SCE M7H0| 2tEE|H [Start] HES ZEI6HA
FPGAS Ct2ZEStC}

b Programmer - F/tmp/Project1/Project! - Project] - [Project1.cdf]* - [} *
g p/Proj ] i) i)

File Edit View Processing Tools Window Help Search Intel EPGA (]

; Hardware Setup... IUSB-BLaster [USE-0] I Mode: IActwe Serial Programming I Progress:

Enable real-time ISP to allow background programming when available

File Device Checksum | Usercode  Program/ = Verfy | Blank-  Examine
Configure Check

33



“ Programmer - F:/tmp/Project1/Projectl - Project] - [Project!.cdf]*

File Edit View Processing Tools Window Help

- [m] X

Search Intel FPGA [5]

e Hardware Setup... | |USE-Blaster [USE-0] Mode: | Active Serial Programming ™

Enable real-time ISP to allow background programming when available

File Device Checksum

Usercode

00000000

M Auto Detect

X pelete

" Add File
% Change File

) save File

* Add Device... ;

Uyp

i pown

Program/ Blank-

Check

Verify

Examine
Configure

FPGA CIR2EE
Progress
CHRRETt

A EC

ELHEH  2Aet ZAB

barO|A CIR2=E7 2A=2E[RUACHE

=

ol O

AA—D1,

» Programmer - F-/tmp/Project1/Project1 - Project? - [Project1.cdf]*

File Edit View Processing Tools Window Help

Search Intel FPGA

s Hardware Setup. Mode: | Active Serial Programming ™

Enable real-time ISP to allow background programming when available

Progress

o File Device Checksum Usercode
»lsar
‘%EIP output_files/Projectl.pof EPCS4 06752E43 00000000
6@ Auto Detect
X pelete
™ AddFile...
]
1 Change File.
2 save File
* Add Device :w.“m.-
ASDI E K
b yp —r b =
i :
V“"Dcw\'\ I FRANRFAN
EPCS4
DATA

34

Program/ = Verify = Blank- Examine
Configure Check
v




5. 45N —2dHE (Hlerarchlcal Project)

MA 7L BRSXH 7le T B2 LHO HAAS F, Al ASHA
st LEe ASH éﬁl 2AISCE ASHe=z A5t bgs et

AsHez dASt= 82, BN TH HAE 7Is¥lz Zeloh ohEo 4
7|5E& Verilog 2= VHDLZ EA5t0 HutUst 2, Al0|dE &3 SEH0
O] &40 l=X| =2I50] BSF Block Symbol FileE A/ g3tCt.

48 ASMMeE Mz22 Z=2HEE ddstn MZ2 CfXel mIY2 Block
Diagram/Schematic I}¥S 2EICt. O] LA M= schematic A7} 753,
oM dgoh BSF X 2to[E2{2|0AM HMSSte CHE =1 e €AY =k
ULE.

O] ool 4x1 HEIEHM(mux41)E VHDLE HAStD BSFE M3 = 4%
ASBHAM ol8sf dASt= uEE ENF1 UACH VHDLE OtL|2f VerilogLt
Schematic &4 22 HHE HAMES ML BSFE Hdst &2 ASOAM
Ol 0|83 2Ag = ULk =T LASHAM Schematic LS ALESHX]|
10 Verilog == VHDLE AFES ASEQ HAHE &€ == JUCL

CHS Ol= 4x1 2EIZEME VHDLZE 2AS & mux41.BSFE d-dsta, ddE
mux41 HE1 YH2M HMSEl= D EHEE HES &% AZHM HES=
MA 1PYO|Ct VHDL CHAl Verilog 2 4x1 HEIZEHME HASIHEI: MES

MAMELT SchematicC 2 MAsH= NtHL SYUsiC

nx

[H

_

sl
£ ¢fIgt HierDesign EH Qo dE= ddE
ZZ2HMEmux41)E MHSBHCL &, HierDesign ZC00| ME2 M E

= s

mux41l ZT2HMEE MMgID d2laF 20| muxd4l. VhdE A

_L
)
r_I_
0
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(O Quartus Prime Lite Edition - C/Users/HANBIT/Desktop/Altera/HierDesign/muxd1 - muxd1 - O X

Fie Edit \iew Project Assignments Processing Tooks Window Help Saarch akera com .
Ofd 0D C | me ST TrFRES LR
Project Navigator | . Hierarchy v|=[g8 x| & mmitvnd [ 4 Compistion Report . muxét [
Entity-Instance BT EE T le S E=
. 1 Tibrary feee;
i Cyctne IV E: EEACECRTCE 2 use 'icec.:tdl_lct;'ic_l‘_ﬁ-'..aﬂ;
B muocdd oy F]
4 Bentity muxdl is
5 # port{ s1, s0 : in std_legic;
6 d3, d2, d1, d0 : in std_logic;
7 - y t out std_logic);
B end muxdl;
] L
10 Barchitecture logic of muxdl is
11 @Ebegin
12 y <= (d0 and Ennt 51) and (not s0)) or
13 (dl and {not s1) and s0) or
14 d2 and 51 and {not s0)) or
15 d3 and s1 and s0);
< 3| %g Lend logic;
Tasks tmwlm ":i a8 x
Task b
L » = TimeQuest Timing Analysis
v P EDA Netist Writer
I Edit Settings
» Program Device (Open Programmer )
W
< > ”{ >
x| Type I Message L]
& © 293000 quartus Prime Full Compilation was successful. 0 errors, 15 warnings
1 w
=|¢ >
= | System(2)  Processing (130)
Ln1T Cold VHOL File 100% 0:01:02

Block Symbol File(BSF) g

AlZ22|0[ 422 VHDL &4 ZAo| 0|¢0| gitt= AS =let = [File &
Create/Update = Create Symbol Files for Current File] M+ 22/5t0]
Block Symbol File(BSF)= ‘44 stCt.

rir
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(J Cuartus Prime Lite Edition - C/Users/HANBIT/Desktop/Altera/ HisrDesign,/muxd 1 - muxd1 - O b4
Fle Edt ‘iew Projec! Assignments Processing Tools Window  Hep )
. it | " SEFSC TP FRES OAVDGE
Dpen Cirls0 | - :
= - mund 1 vhd I:_E 4y Compilatesh Repon - muxd]
Class CiriFad L = =
BMT EE T fu B OHD
A New Project Wizasd 1 “T1ibrary leee; ] o
bE  Open Propc CtrieJ ‘; R a0 5 t.all;
e Prieg 4 Bentity mux4l is
et 5 B port( s1, s0 : 1n std :
Ciose Project ] !- d3, d2, di, d0 : in std_lo :
7 ¥ : out std_logic);
E ]1:rld mux4l;
g L
Save A 10 pBarchitecture logic of muxd4l is
= 11 gbegin
P Savesl Ciri+Shift=5 12 y <= Edg - E t s1) ar (not s0))
13 di T 51) and 50) o
File Properies 12 (d2 51 (not s0))
15 1 x (d3 51 s0);
Creale | Update » e cagr Fiie ervl Fie
Create Symbod Fies for Current Fie
Cenver Programmng Fies Create AHDL inciude Fies for Current Fle
1 Page Setup Craake Veniog Relsnlialon Templale Fies for Curment Fie
q— Peint Prowiew Create WHOL Component Declaration Fies for Currend Fie
== print CintP e Daslon i
Recent Fles ¥ .
Recen Projecis ¥ v ol ‘ ’
e i Createfipaste PS File f1 warning
P Create Board-Level Boundary-Scan Fie | »
= < »
= Sysiem (2} Processing (S AT — ’
Croate symbol fies for current fie 100% DODE-03
XIAFC] T2 X M
A7 Z=HE 479
O TmTEANEE OIS = (o] XIAFO| Im = XA = (H; i (@]
AHET'_‘ —E_IEE o EO|_|' EEI |_|'0'” —‘—l ol-‘l"l —E _IE OI,:.(H|erDe5|gn)_
AMAMS I = II VS ol ] = AXSH =
= c|>'|o-|°|_|'|:|' Ol[[H EEIO'” I:I't ii—ﬂgﬂ' AAQ—E %‘EE To-lexl =
= =g = Eo L= 7t = IT A = A A
= HAIXI7H Z28E|=0|, [No] HES =8 €2 200 Z2HMEE dd
—t
otCh.

(h Quartus Prime

Project directory "C\Users\HANBMDesktop\Altera\HierDesign” already contains a
project. If the projects share the same files, edits made while working on one project
could affect the other project. Do you want to select a different project directory?

No

A9 Z2HE WY

Schematic A E sl [File & New = Block Diagram/Schematic File] O
22 MEisiCh ol MME mux41 BSF It LHIZHOAM Ha3dt= D
HEES 0/80t0 dejHez MHASH| fet #ES0|CE
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Unnersty Program VT
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Biock Symeol Fie
Chan Descripton Fie

=3 o -

e. mux4l M8 &
- Schematic 24 =tH 2{0AM OFRA
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A
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xtS ot Mo
o= -1 O
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- g
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U Broest eent rote
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A2 Project 24 0=
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b Quartus Priene Lite Ecition - C/Users/HANBIT, Deskiog altera veesgn HaDesign - HigrDesign
fe [ Vew PFmpcl Asggerests Frocesssg  Took  Window s
(OERIFOD D C F/EEL TP VES QADR
Pigect Hagaler | o Hiwarety *"E Q8 2 Bieck! bdr a
Eaity rilsnes q hﬂ.*h1-.'l:;'|]'|-111..“.3"|:'-"-;' o | "lpl‘-i' n‘flﬂl;‘. HH ;'r
iy Cychas W E FR4CEEFTTCE N S N N T T i
* HerDesgn 1y
Taaas I'.n.h&n *FE QS
ik -
w B Compis Deagn
= Erakss d Syoiresi
B Finar (Pasce & Azuta)
= Aszembler Generpie programr
L . 3 1
"1 Type ID Messiage
5
')
]
B Sywiam Fmcsssng
33 %
. D EEHEE 28
- Schematic 27 =tH 2I0|M CHAl Or2A AF HES HE
Symbol &2 I 2Lt Libraries: 0l Al [primitives = storage = dff|E

|_

1 [OK] HEZ
Z M=t

i

T symbol

Libraries:
[ v & primitives
+ € buffer
£ logic
» O other
& pn
~ [ storage
& arr

£ dffe
£t difea
Fh Attane

[atr
[[] Repeat-insert mode

Insert symbol as block

223t LibraryOlls LE[ZIOIN A B3t ZHzmd
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¢. D EEHEE 28

- 32O LIHX| E22 MASH = 'HierDesign.bdf'2 XZ&SICE Ol input,
output EHAt= =-010|2& =8 ™ot vCCe & &tE HE 289
Of Symbol & Z[®7Ll =0t0|25 2&3t0] Symbol &= =[] ot
Ct.

b Quartus Prime Lite Edition - C-/Users/HANBIT/Desktop, Altera/HierDesign/HierDesign - HierDesign - [m} X

File Edt Vew Project Assignmenls Processing Tools Window  Help o

1~ d 0" HierDesign N SECEL TP FES DAV

Project Navigator ., Hisrarchy =08 x = HierDesign.bdf* [ x]

Entity-instance

&% Cyclone \V E: EP4CEEF1T7CE co co c
* HierDesign Iy

BrQ¥ADR-O0T7T7TNNY

Tasks Compilation * =0/ x

Task ()
~ [ Compile Design

P Analysis & Synthesis

|+ Fitter (Place & Route)

P Assembler (Generate programm

.;. Type ID Message

!

h. oY U FPGA CI2EE

- CiA] Huret 2 43 HAIX[E 2Qlott). O|F A[Z2|0[ 41t FPGAO| Lt
2EE5HY HAlst= aEe A0M Ao W LS}
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Ok Quartws Prime Lite Edition - C:/Users/HAMBIT/Desktop/Altera/HierDesign/HierDesign - HierDesign

File Edt Vew Project Assignments  Processing

Tools Window Help

0w al+00n"»cll

NG D EFED DAVE

- [m) pd

Search akera.com .

Projct Navigator | .\ Herarchy v = Q& x| T HierDesign bdf [0 & Compiation Report- HierDesign [0
p— - 3e
2\ Cyclone N E: EP4CESF1TCS E5 Flow Summary Flow Status ) Successful - Tue Aug 16 16:42:23 2018
- - Quartus Prime Verson 16.0.0 Buid 211 0472712016 SJ Lie Edition
> ER HierDesign ry B Flow Settings.
R Flow Non-Default Giobal Setting -
Top-level Entity Name HierDesign
B Flow Elapsed Time Famiy Cychne VE
B Flow 05 Summary Device EPACERFITCE
= Flow Log Timing Models Final
> [ Analysis & Synthesis Total logic elements 2/62T2(<1%)
5 B Fiter Total combnational functions ~ 2/6272(<1%)
> B Assembler Dedicated logic registers 1/6272(<1%)
h N > [ TimeQuest Timing Analyzer b .
211 i oA ettt e srrm(ex)
Tasks Compilation = QF = Messages
- | O row Total memory bits /276,480 (0% )
Task Al O Fow Multplier 5-bit elements  0/30 (0% )
v P Compie Design Total PLLs 0i2(0%)
> P Analysis & Synthesis
» P Fitter (Place & Route)
» P+ Assembler (Generate programm
| NSy A mal e 7
> (1 >
Type ID Message A
(] 293000 Quartus Prime Full Compilation was successful. 0 errors, 16 warnmings
W
< >
= | System  Processing (126)
502,2  100% 000149
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6. DIGCOM-A1.2 C|H}O|A

a. Device Pin Options

M
=

DIGCOM-A120|A = &

7-H|1HE FND, 167H29] TA

I*I(Mo M1) ol 157H°| LED(D1 ~ D15)7} %

ol=x= N
oM 2t Yz WAIQ| IS 2ojFEC
/. OUTPUT REGISTERS .\
[ A X X X | o000 0O [ X X X N ]
DIGCOM-A1.2 7-AQHE] g %
—.—| ; i ity ity FND o W o o Lo
3 _ ANy 'mmnn’ ‘annn h . . . . . N
¢ [H H ARZD ARZI ARZZ = =
'Y EE D1 D2 D3 04 D5 D6 O D& D9 D10 DT D12 D15 D14 DO
] 5888, l::::ll::::ll::::l === = =i=l=l=1=l=]--
P 3 R IEN fe} PC DR AC INPR IR TR OUTR
— W ruo ~
o- oe I[::] & LED D1~B7 LED D8~ 4039
S 1 mawn A=A
109 mmwn T |=HE
o0 H H w2 - = b4
o0 = E oo
papd e - Emecn o :8 B o0
o0 EDE w20 |=EE -4
[l s L] ﬂ- ( X ]
on H H :E EEKS - = Ld.d
> = B Eo: o
= . " m s e o : ']
ﬂ”‘* p22 ' l Emec = =T o0
J2 2 g B E - = ([ X ]
UL . I:l 5 © .I:‘”H - ﬁ ==z uin U ::
L e I - 2
T s LE L EI = = sllallslls 01: CLK ::
|l]3 I:l ' = = 00 NOPl o @
- [ ST oo
on |l]§ 120 =] L ]
—{ |
® 21
ol @ @ cooo @
GND 5V 33V 12V

m FAHE

i skCh
I_ = O
3]
HMo =z ALY
IHE 2
ﬁ

|-

HX= 3742
-?I*l(OxO ~ OxF), 4702 FAIHE

| 2xt2)
A%

ALQIK[(SWO ~ SW7), 2712] &2}0|=

JCEH [22] 312 DIGCOM-A1.2

L8 n3 U U4
% 2foic X |x|(swo ~SW7)

AL2|X[(0x0 ~ OXf)Q| &

SkCH
=

o
0x0 0x1 0x2 0x3 0x4 0x5 0x6 0x7
N3 P3 R3 T3 T2 R4 T4 N5
0x8 0x9 OxA 0xB 0xC 0xD OxE OxF
N6 M6 P6 M7 K8 R5 T5 R6
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m ZAHE AQIX|(RESET, FGO, REG, STEP) T &t
RESET FGO REG STEP
L8 P8 M8 N8
m S2}0|E AQ[X|(SWO ~ SW7) T &gt
SWO0 | SW1 | SW2 | SW3 | SW4 | SW5 | SW6 | SW7
R9 T9 K9 L9 M9 N9 | R10 | T10
m £2t0|E AQX|(MO, M1) H &Y
MO M1
R12 | T12
m 7-MIHEFND3 ~ FND1) H &g
FND3A FND3B FND3C FND3D FND3E FND3F FND3G FND3DP FND3Sel2 FND3Sel1
o A8 B8 c8 D8 E8 F8 A7 B7 F6 F7
FND2A FND2B FND2C FND2D FND2E FND2F FND2G FND2DP FND2Sel2 FND2Sel1
bz C6 A6 B6 E7 E6 A5 A2 B5 A4 B4
FND1A FND1B FND1C FND1D FND1E FND1F FND1G FND1DP FND1Sel2 FND1Sel1
et c14 D14 D11 D12 A13 B13 A14 B14 E11 E10
PIG.‘I DlE'? 10
'r?:” Flllﬁe DIG.1 l I riI L
'_'%) ﬁ‘—r k ¥ |:_§ L :f g FaELFEEE s

m LED(D1 ~ D7)

o

Of

yait

8

e}

- =2 0O
D1 D2 D3 D4 D5 D6 D7
A12 | B12 | A11 | B11 | C11 | F10 F9
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n LED(D8 ~ D15) &l =gt

D8 D9 D10 | D11 D12 | D13 | D14 | D15

F11 A15 | A10 B10 C9 D9 E9 A9

m ST ZE T SEh00 ~1031) E Y
100 101 102 103 104 105 106 107
N13 M12 L12 K12 N14 P15 P16 R16
108 109 1010 1011 1012 1013 1014 1015
K11 N16 N15 L14 L13 L16 L15 J11
1016 1017 1018 1019 1020 1021 1022 1023
K16 K15 J16 J15 J14 J12 J13 G16
1024 1025 1026 1027 1028 1029 1030 1031
G15 F13 G11 F15 B16 F14 D16 D15

m Oscillator : E16, E15
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7. USB-Blaster E2|0|H HEX[(64H|E | X210 7|F)

Usb blaster 0|52 AZstH Ctgat 242 HA|X|7F BEAIZIH, HO{EO|AM FX|
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> | drivers

4 usb-blaster Windows7

4 | usb-blaster
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